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Troubleshooting Federal 
Child Count Reports
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The Department of Education and Workforce funds development of EMIS training 
materials as part of the EMIS Alliance grant. There is an expectation that ITCs will 
utilize these materials in training provided to your districts. That said, there are 
restrictions on use of the EMIS Alliance materials as follows: Materials developed as 
part of the EMIS Alliance program must be provided at no cost to your training 
participants. If you utilize the EMIS Alliance training materials – in whole or in part 
– you must not charge participants a fee to attend the class where the materials 
are used. Likewise, you may not use the materials or any portion thereof in any 
event where a fee is charged to attend. Exceptions must be approved in writing by 
the Department in advance of scheduling/promoting any event which may violate 
these restrictions.
Questions regarding appropriate use of EMIS Alliance materials, or requests for 
exception to the restrictions noted above, should be directed to Melissa Hennon 
[Melissa.Hennon@education.ohio.gov].
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Overview
• The Federal Child Count (FCC) 

• Counts students with disabilities who are receiving special education 
services according to their IEPs as of October 31

• Determines the amount of Special Education Part-B IDEA and Early 
Childhood Special Education funds Ohio receives

• Is collected from all LEAs (except for ESCs and JVSDs) through the 
Education Management Information System (EMIS) and submitted to 
the US Department of Education (USDOE)

• Today’s presentation will focus on troubleshooting the EMIS 
FCC Reports, which are generated throughout the EMIS data 
submission process
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EMIS Data Collections and the FCC Snapshot

• Collections containing the FCC report
• Beginning of Year Student (S) Collection
• SOES Beginning of Year Student (S) Collection

• Collections are scheduled to close December 19, 2025
• FCC reporting ends when the Student and SOES Collections close
• There is no Final Correction Opportunity for the FCC
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FCC Reports

• Level 2 Reports
• (FCCD-001) Federal Child Count Detail
• (FCCS-001) Federal Child Count Statement of Assurances

• FCC reports are updated nightly
• Reports may include data reported by other LEAs
• Always review the most recent version of the reports 

throughout the data collection process
• Submit updated EMIS data to correct any errors in the reports
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Level 2 Reports 
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Select the Level 2 Reports link
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FCC Reports 

7

FCC was added to the 
filter in this example 

Select “Show Reports”

7



10/28/2025

8

Formatting the FCC Detail Report

• Open the (FCCD-001) Federal Child Count Detail Report
• Wrap text header row
• Freeze top row
• Expand all columns
• Apply filters
• Better yet, run your macro!
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Quick Check • Are you using the most recent 
version of the report?

• Are you able to open and format 
the CSV report to begin the review 
process?

• Can you apply filters to all 
columns? 

The Federal Child Count Detail 
Report provides detailed  
student data related to the 
Federal Child Count. This 
report is critical tool for 
reviewing and correcting data. 
Districts should carefully 
review it for accuracy and 
completeness.
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Troubleshooting 
the Federal Child Count 

Detail Report
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Troubleshooting the FCC Detail Report

The next series of slides will review data contained in the 
report including

• Severity Codes and Numbers
• Federal Child Count Flag
• Inclusion Rules - Who is and is not included in my FCC?
• FCC Report Data
• Status Codes and corrective actions required
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Severity Codes
• Severity Codes

• Report is sorted from least severe to most severe
• Each Status Code correlates to a specific Severity Code
• All students should be reviewed regardless of Severity Code

12

I – Informational 
W – Warning
C – Critical 
F – Fatal

12



10/28/2025

13

Federal Child Count Flag 

• FED CCT FLAG 
• Y – Student is included in the Federal Child Count
• N – Student is not included in the Federal Child Count
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Who is included in my FCC?
• In most cases, students count at their resident district 
• Exceptions: 

• Students attending: 
• Community Schools
• STEM Districts
• Buckeye United (DYS)

• Non-Public Students Receiving Related Services: 
• Counted at the traditional district providing the related services, if an active IEP event is 

reported as of October 31
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Who is not included in my FCC? 

• Students with a disability as of October 31 who do not have 
an active IEP event reported as of October 31

• Students reported with the following IEP outcomes:
• IEPR – IEP Complete – Parental Refusal
• IENS – IEP Complete – Not Served
• IEDP – IEP Resulted in Due Process

• For more details and exceptions, refer to the FCC Level 2 
Report Explanation, section “Include in USDOE Count”
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FCC Report Data 
• Disability Condition Code

• Student must have a disability reported in EMIS as of October 31 
to be included on the FCC report 

• Review carefully to ensure accuracy

• Student Age Number
• Represents the student’s age as of October 31
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FCC Report Data, cont’d
• Legal District of Residence
• FED CCT ALT IRN

• This field is populated when the student has a Status Code of FC0006, 
with the LEA IRN of the district where the student counts.

• Sent Reasons and IRNs
• Displays if relevant to the FCC report
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FCC Report Data, cont’d
• FED CCT LRE Code – Least Restrictive Environment Code 

• If field is blank, the student is not included in the count 
• Value comes from IEP, FN270, or is derived by DEW

• DIST LRE SRC CODE and DIST LRE SRC DESCR 
• Source codes indicate what data the report is using
• Use in combination with the Status Code value to determine what is being 

reported for each student
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DIST LRE Source Codes
• 1 - No Disability on October 31 
• 3 - Student’s age is not 3 – 21 
• 5 - No IEP Reported 
• 7 - FN270 Override
• 8 - GE Record
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DIST LRE Source Codes, cont’d
• 9 - How Received = 6 

• Ages 5 and up, Not Grade Level PS: FED CCT LRE CODE = IE39
• Ages 6 and up, Grade Level PS: FED CCT LRE CODE = IE39

• C - How Received = 6 and Grade Level = PS 
• Ages 3 to 5 and Grade Level PS:  FED CCT LRE CODE = IE51 

• A - Sent Reason = AU or JP 
• age 3-5: FED CCT LRE CODE = IE51
• age 6 or older: FED CCT LRE CODE = IE39

• B - Changed to DYS LRE 
• Appears only on DYS report 
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Quick Check • Are all students appearing on the 
report as expected?

• Has someone verified the data for 
accuracy?

• Has updated EMIS data been 
submitted to correct any 
inaccuracies on the report? 

The Federal Child Count Detail 
Report contains data specific to 
students with disabilities. 
Understanding each column is 
essential for analyzing the data 
for accuracy and completeness. 
Not every issue is flagged as an 
error, so is important to 
carefully review all data on the 
report. 
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FED CCT Status Codes
FED CCT STATUS CODE and FED CCT STATUS CODE DESCR

• Indicates the status of a student regarding inclusion in the count
• Shows whether a data issue exists or if no errors are identified 
• Even if no errors are reported, data should still be reviewed for 

accuracy 

22

22



10/28/2025

23

FED CCT Status Code FC0001

Filter on FC0001 
• On Oct 31, Student age is outside the 3-21 range (Fatal)

• Source Code 3 - Student age is not 3 – 21 
• FED CCT FLAG - N

• Check the student’s reported date of birth on the Student 
Demographic (GI) Record to confirm age

• If the date of birth is incorrect, make the correction and submit 
updated EMIS data
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FED CCT Status Code FC0002

Filter on FC0002 
• Unable to translate LRE-must report FN270 element 

(Critical)
• Source Code 7 - FN270 Override
• Or Source Code 8 - GE Record
• FED CCT Flag - N

• As of October 31, the student’s IEP Outcome (LRE) must 
align with the student’s age and grade level

• If it does not align, report the correct LRE the FN270 
element
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Age, Grade Level, and Expected LRE
• Age 3 to 5, Preschool Grade Level - Count as Preschool Student 

• Preschool LRE Expected (IE51-IE72)

• Age 4, Kindergarten Grade Level - Count as Preschool Student
• Preschool LRE Expected (IE51-IE72)

• Age 5 and up, Kindergarten Grade Level - Count as School Aged 
Student 
• School Aged LRE Expected (IE13-IE39)

• Age 6 and up, Any Grade Level, including Preschool - Count as 
School Aged Student
• School Aged LRE Expected (IE13-IE39)
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Updated October 31 IEP Outcome Element (FN270)
• The current IEP outcome and FN270 values should not be the same
• When the FN270 value is reported correctly the LRE that aligns with 

the student’s age and grade level will appear in the column FED CCT 
LRE CODE

• When reported incorrectly the FED CCT LRE CODE column will be 
blank

26

Reporting the FN270 Element

Incorrect 

Correct
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Additional Information on FN270 Reporting 

• The Department reviews the LRE on the latest reported IEP 
event effective as of October 31

• The value in the FN270 element takes precedence over the LRE
• Reporting an FN270 value is not limited to PS and KG students
• For this element to be valid for the Federal Child Count, the 

student must already have an IEP reported to the Department 
that is valid on October 31. If no valid IEP exists on October 31, 
then the FN270 value will be ignored
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Additional Information on FN270 Reporting , cont’d
The LRE typically does not change without a new IEP being 
completed and reported, but there are some cases, especially for 
IEPs reported in the prior year that are still in effect on October 
31, where the LRE could change

• Examples include but are not limited to 
• a student whose parent originally consented to services but pulled the student 

from services prior to October 31 
• an expelled student placed in an alternative placement that is in effect on 

October 31
• a preschool student (especially part-time), whose parental placement in a 

private preschool could change the LRE
• For questions regarding FN270 reporting, please contact your ITC 
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FED CCT Status Code FC0003

Filter on FC0003 
• CIEP most recent IEP - should be no disability (Warning)

• Source Code 8 - GE Record
• FED CCT FLAG - N

• Verify the CIEP event and confirm that the student’s disability code 
is reported as ending on the date of the CIEP event

• If the student’s disability code on the Student Attributes - Effective 
Date (FD) Record is not reported as ended, make the correction 
and submit updated EMIS data
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FED CCT Status Code FC0004

Filter on FC0004 
• No IEP reported for Oct 31 date (Fatal) 

• Source Code 5 - No IEP Reported
• FED CCT Flag – N 
• FED CCT LRE CODE – Blank 

• Verify the student’s special education event records as of October 31
• Confirm the most recent IEP was reported to EMIS
• If appropriate, report an NIEP
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ODDEX Records
Special Education Data Tab 

• Use to verify if the student’s IEP events were reported to EMIS

31
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NIEP Date Type - No IEP

• NIEP events for expired or non-transferable IEPs
• 10 - Student newly transferred in; IEP adoption determination not 

complete; services being provided based on prior IEP
• 11 - IEP expired; new IEP not in place; services being provided 

based on prior IEP

• NIEP events using the non-compliance reason 12 can be 
used until the end of the IEP that was not reported to EMIS 
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FED CCT Status Code FC0005
Filter on FC0005

• Student does not meet inclusion filter in this district (Warning)
• Source Code 5 - No IEP Reported 
• or Source Code 7 - FN270 Override
• or Source Code 8 - GE Record
• or Source Code 9 – How Received = 6 
• FED CCT Flag – N

• Shared students can have this Status Code at the educating district
• Shared students where IEPs are not reported can also have this 

Status Code with Source Code 5 – No IEP Reported
• For more details and exceptions, refer to the FCC Level 2 Report 

Explanation, section “Include in USDOE Count”
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FED CCT Status Code FC0005, cont’d 

Filter on FC0005
• Student does not meet inclusion filter in this district (Warning)

• Source Code 9 – How Received = 6 
• FED CCT Flag – N

• Applies to Non-Public special education students receiving 
related services from reporting district with no IEP reported on 
October 31
• Individualized Service Plans (ISP) are not considered for this report
• If no IEP is in place on October 31, the student is not included in 

the Federal Child Count
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Students Reported by Multiple Districts

Tie Breakers 
1. Student will count at Buckeye United (060988) if reported by Buckeye 

United 
2. Student will count where Reporting IRN = District of Residence IRN

~OR~ where Reporting IRN is reporting a How Received code of    
M (Community School) or K (STEM District)

3. If multiple entities are claiming the student in the same way (as in #2 
above), the student counts for the entity with the later admission date

4. If multiple entities are claiming the student in the same way (as in #2 
above), and report the same admission date, the student will not count for 
any district 
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FED CCT Status Code FC0006
Filter on FC0006 

• Student counting in alternative district - does not count in your district 
(Warning)

• Source Code 5 – No IEP Reported - verify if special education events need to be reported 
• or Source Code 7 - FN270 Override 
• or Source Code 8 - GE Record
• or Source Code 9 - How Received = 6
• or Source Code C - How Received = 6 and Grade Level = PS
• or Source Code A - Sent Reason AU or JP
• FED CCT Flag - N

• Student counts at the IRN listed in the FED CCT ALT IRN column
• Review data in ODDEX to compare how data is being reported
• Communicate with the alternative district to determine how this student should 

be reported

36

36



10/28/2025

37

FED CCT Status Code FC0007
Filter on FC0007

• Student excluded -conflict in where the student should count (Fatal) 
• Source Code – 7 FN270 Override
• Or Source Code – 8 GE Record
• FED CCT Flag - N

• The student will not be counted at either entity because could not 
determine where this student should count

• Review data in ODDEX to compare how the student is being reported 
by both entities

• Communicate with the other entity to determine how this student 
should be reported

37

37



10/28/2025

38

FED CCT Status Code FC0008
Filter on FC0008

• No errors identified in DEW processing (Informational) 
• Source Code 7 – FN270 Override 
• or Source Code 8 – GE Record
• or Source Code 9 – How Received = 6
• or Source Code A – Sent Reason = AU or JP
• or Source Code B – Changed to DYS LRE (appears on Buckeye United FCC Report) 
• or Source Code C – How Received = 6 and Grade = PS 
• FED CCT Flag – Y 

• Data for the students should be reviewed for accuracy
• Apply filters to verify elements such as disability conditions and LREs
• Engage district staff to help verify data accuracy and completeness
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Quick Check
• Have all status codes been 

reviewed, and all reporting issues 
corrected? 

• When corrections have been 
made in the student information 
system (SIS), has that updated 
data been submitted to EMIS?

• Based on inclusion criteria, are all 
special education students being 
counted correctly?

The Federal Child Count Detail 
report displays all students, 
including those included and 
not included in your Federal 
Child Count. The report will 
also indicate students with 
issues preventing them from 
being included. Regular 
review is important, as the 
report can be affected by 
reporting from other entities.
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Troubleshooting 
the Federal Child Count Statement of 

Assurances Report

40
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Open the FCC Statement of Assurances Report 

41

Format the report 
by wrapping the 
text in the header 
row and expanding 
all columns 
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Understanding Statement of Assurances 

• The report includes students
• who have a FED CCT Flag = Y
• 3, 4, and 5 year-olds with a disability
• age 6 to 21 in each disability-specific category

• Using the criteria above, the next series of slides will match 
the FCC Detail Report against the FCC Statement of 
Assurances Report 

• When counts on this report are incorrect, filtering allows you 
to identify which students are included or not included
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Filter on FCC CCT Flag 

43

Select Y on the 
FED CCT Flag Filter on 
the FCC Detail Report 

These are the students 
who are included in 
the Statement of
Assurances Report
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Add Second Filter on Student Age Number 

44

Select ages 3, 4 and 
5 on the Student Age 
Number Filter

These students are included in the 3, 
4, and 5-year-olds with any disability 
on the Statement of Assurances report 
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Matching Data Between Reports

45

1. From the filtered students on the FCC Detail Report, 
select a range of cells and see the “count” appear at 
the bottom of the spreadsheet.

2. This will match the count on the Statement of 
Assurances. 
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Arrange All 

46

With two spreadsheets 
open at the same time, 
from the View tab select 
“Arrange All” and then 
“Vertical” and “OK”
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Arrange All cont’d

47

“Arrange All” allows 
both spreadsheets to 
be viewable at the 
same time
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Change the Student Age Filter

48

Change the filter for the Student 
Age Number column to include 
all ages except 3, 4, and 5

Leave the FED CCT Flag 
Column filter set to 
show only Y values 
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Add a Third Filter

49

Select one disability 
code at a time

Add a third filter in 
the DISAB CNDTN 
CODE column
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Match the Data Between the Reports 

50

2. This will match the count 
on the Statement of 
Assurances. 

1. From the filtered students on the 
FCC Detail Report, select a range 
of cells and see the “count” appear 
at the bottom of the spreadsheet. 
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Quick Check • Can you match the data between 
the two reports using filters?

• Are you seeing the numbers of 
students that you were expecting? 

• Has this data been shared with 
others in your district?

The Federal Child Count
Statement of Assurances 
Report is derived from the 
same data that is on the FCC 
Detail Report. Filters can be 
used to match data between 
the two reports. The 
Statement of Assurances may 
be requested by auditors.
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Summary

• The FCC Reports contain both data to verify and issues that 
need correction.

• Some issues can be corrected, while others are simply 
indicate that a student cannot be included in the count 

• Collaborate with district staff to verify the data is both 
correct and complete

• “No errors” does not necessarily mean that your data is 
accurate
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Resources
• Federal Child Count Detail Report and Federal Child Count 

Statement of Assurances Report Explanation
• DEW Home > Data > EMIS > Documentation > EMIS Validation and 

Report Explanations 

• EMIS Manual 
• DEW Home > Data > EMIS > Documentation > EMIS Manual

• Your district staff
• Your ITC
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Questions?
If you would like a certificate of attendance for this 

training, you must complete the below feedback form 
within 5 business days of this training
https://tinyurl.com/EA-District-Feedback
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